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About this book

This book provides information about installing and using IBM Director Capacity
Manager.

Who should read this book

Conventions and terminology

These notices are designed to highlight key information:
Note: These notices provide important tips, guidance, or advice.

Important: These notices provide information or advice that might help you avoid
inconvenient or difficult situations.

Attention: These notices indicate possible damage to programs, devices, or data.
An attention notice appears before the instruction or situation in which damage
can occur.

Related information
This topic provides links to additional information related to IBM Director.
IBM Director resources on the World Wide Web
The following Web pages provide resources for understanding, using, and

troubleshooting IBM Director and other systems-management tools.

IBM Director information center
publib.boulder.ibm.com/infocenter/eserver /|
v1r2/topic/diricinfo/fgm0_main.htm]|

Updated periodically, the IBM Director information center contains the
most up-to-date documentation available on a wide range of topics.

IBM Director Web site on ibm.com®
www.ibm.com /servers/eserver /xseries /|
systems_management/ibm_director/|

The IBM Director Web site on ibm.com has links to downloads and
documentation for all currently supported versions of IBM Director.
Information on this site includes:

e IBM Director 5.10 - downloads and documentation
e IBM Director 4.22 - downloads and documentation

* IBM Director 4.22 Upward Integration Modules (UIMs) - downloads and
documentation

e IBM Director 4.21 - downloads and documentation
e IBM Director 4.20 - downloads and documentation

* IBM Director Hardware and Software Compatibility document - lists
supported @server and IBM® xSeries® systems, as well as all supported
operating systems. It is updated every 6 to 8 weeks.
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e Printable documentation for IBM Director - available in Portable
Document Format (PDF) in several languages

IBM Systems Software information center
fwww.ibm.com/servers /library /infocenter /|

This Web page provides information about IBM Virtualization Engine ",
IBM Director, and other topics.

IBM ServerProven® page
|www.ibm.com /pc/us/compat/ index.htmll

This Web page provides information about IBM xSeries, BladeCenter®, and
IntelliStation® hardware compatibility with IBM Director.

IBM Systems Management Software: Download/Electronic Support page
www.ibm.com /servers /eserver/xseries /|
Systems_management/ibm_director /|

Use this Web page to download IBM systems-management software,
including IBM Director. Check this Web page regularly for new IBM
Director releases and updates.

IBM Servers
www.ibm.com/servers /|

This Web page on ibm.com links to information, downloads, and IBM
Director extensions such as Remote Deployment Manager, Capacity
Manager, Systems Availability and Software Distribution (Premium
Edition) for IBM servers:

+ IBM BladeCenter

* IBM iSeries™

« IBM pSeries®

* IBM xSeries

* IBM zSeries®

IBM Redbooks™

fwww.ibm.com /redbooks /|

You can download the following documents from the IBM Redbooks Web page.
You also might want to search this Web page for documents that focus on specific
IBM hardware; such documents often contain systems-management material.

Note: Be sure to note the date of publication and to determine the level of IBM
Director software to which the Redbooks publication refers.

« [Creating a Report of the Tables in the IBM Director 4.1 Database (TIPS0185)
* |IBM Director Security| (REDP-0417-00)

* IBM eServer"" BladeCenter Systems Management with IBM Director V4.1 and Remotd
Deployment Manager V4.1 (REDP-3776-00)

o |Implementing Systems Management Solutions using IBM Director| (SG24-6188)
» |Integrating IBM Director with Enterprise Management Solutions| (SG24-5388)
* |Managing IBM TotalStorage® NAS with IBM Director| (SG24-6830)

* |Monitoring Redundant Uninterruptible Power Supplies Using IBM Director|
(REDP-3827-00)
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Remote Supervisor Adapter

Remote Supervisor Adapter overview
fwww.ibm.com /support/docview.wss?uid=psg1IMIGR-4UKSMIL]

This Web page includes links to the Remote Supervisor Adapter User’s Guide
and Remote Supervisor Adapter Installation Guide.

Remote Supervisor Adapter II overview
www.ibm.com /support/docview.wss?uid=psgIMIGR-5011¢

This Web page includes information about the Remote Supervisor Adapter
II.

Other documents

For planning purposes, the following documents might be of interest:

* |Planning and installation guide - IBM eServer BladeCenter (Type 8677)

. [1BM Management Processor Command-Line Utility User’s Guide version 3.00|

How to send your comments

Your feedback is important in helping to provide the most accurate and highest
quality information. If you have any comments about this book or any other IBM
Director publication, use the form for reader’s comments is provided at the back of
this publication. If the form has been removed, you may address your comments
to:

International Business Machines Corporation
Design & Information Development
Department CGFA

PO Box 12195

Research Triangle Park, NC 27709-9990
US.A.

About this book X1
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http://www.ibm.com/pc/support/site.wss/document.do?lndocid=MIGR-53670
http://www.ibm.com/support/docview.wss?uid=psg1MIGR-54214
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Chapter 1. Getting started

Introducing IBM Director

This topic provides an overview of IBM Director.

IBM Director is an integrated, easy-to-use suite of tools that provide you with
comprehensive systems-management capabilities to help realize maximum system
availability and lower IT costs. Its open, industry-standard design enables
heterogeneous-hardware management and broad operating-system support,
including most Intel® microprocessor-based systems and certain IBM @ server
System p5®, iSeries, pSeries, System 79® and zSeries servers.

IBM Director automates many of the processes that are required to manage
systems proactively, including capacity planning, asset tracking, preventive
maintenance, diagnostic monitoring, troubleshooting, and more. It has a graphical
user interface that provides easy access to both local and remote systems.

IBM Director can be used in environments with multiple operating systems and
integrated with robust workgroup and enterprise management software from IBM
(such as Tivoli® software), Computer Associates, Hewlett-Packard, Microsoft®,
NetlQ, and BMC Software.

IBM Director environment

IBM Director is designed to manage a complex environment that contains
numerous servers, desktop computers, workstations, mobile computers (notebook
computers), and assorted devices. IBM Director can manage up to 5000 Level-2
systems.

An IBM Director environment contains the following groups of hardware:

* One or more servers on which IBM Director Server is installed. Such servers are
called management servers.

* Servers, workstations, desktop computers, and mobile computers that are
managed by IBM Director. Such systems are called managed systems.

* Network devices, printers, or computers that have Simple Network Management
Protocol (SNMP) agents installed or embedded. Such devices are called SNMP
devices.

* Additional managed objects such as platforms and chassis. Collectively, all
managed systems, devices, and objects are referred to as managed objects.

[Figure 1 on page 2| shows the hardware in an IBM Director environment.

© Copyright IBM Corp. 1999, 2005 1
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Figure 1. Hardware in an IBM Director environment

Capacity Manager

2

The Capacity Manager task is a resource-management planning tool that you can
use to monitor critical resources, such as processor usage, hard disk capacity,
memory usage, and network traffic; identify current or potential bottlenecks for an
individual server or a group of servers; generate performance-analysis reports and
recommends ways to improve performance and prevent diminished performance
or downtime; and forecast performance trends.

Capacity Manager has three components:

Monitor Activator
Displays the status of resource and performance-analysis monitors on
managed systems; you can specify which monitors are active. When new
hardware is detected, corresponding monitors are activated automatically.

Report Generator
Provides Report Definitions, which you can customize for generating
reports.

Report Viewer
Provides four views of your generated report data and graphs of monitor

performance.
Icon %
Supported IBM Level-2 managed systems
Director objects
Supported operating For detailed operating-system support information, see the IBM
systems Director information center on the Web at

publib.boulder.ibm.com /infocenter/eserver/|
v1r2/topic/diricinfo/fqm0_main.htmi|

Availability Extension to the standard IBM Director product, which must be
purchased separately.

IBM Director Capacity Manager Installation and User’s Guide
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Required hardware or | Designed specifically for use on xSeries and Netfinity® servers.
hardware limitations

Required software None

Required protocols None

Required device None

drivers

Mass Configuration No

support

Scheduler support No

Files associated with Any generated reports that you selected to save to a file. Unless
this task you specify another directory in the report definition, these files

are located in the following applicable directory:
« (For Linux®) /opt/ibm/director/reports where:
+ (For Windows®) c:\Program Files\IBM \director\reports

where:

e director is the default directory in which IBM Director Console
is installed.

e reports is the default directory where the reports are stored and
exported by the user.

Events associated with |Capacity Manager

this task
For detailed events information, see the IBM Director information

center on the Web at[publib.boulder.ibm.com /infocenter/eserver /|
[v1r2/topic/diricinfo/fqm0_main.html|

Performance

IBM Director provides a robust tool for monitoring and managing the performance
of your environment, called Capacity Manager.

Performance-analysis monitors

This concept describes the performance-analysis monitors.

Performance-analysis monitors are a subset of resource monitors that are
considered critical and are used to make performance recommendations. The
performance-analysis monitors are activated by default when you install Capacity
Manager.

These are the types of performance-analysis monitors:
* Processor usage

* Memory usage

 Disk usage

¢ Network traffic

Note: You must turn on all four types of performance-analysis monitors for a
report to display a performance-analysis recommendation.

Capacity Manager automatically discovers new disk and LAN resource monitors
and removes monitors for devices that no longer exist. Performance-analysis
monitors for Windows network adapters and physical disks are discovered when
the Windows network adapters and physical disks are added to the managed

Chapter 1. Getting started 3
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system. If a checked network adapter or physical disk has been removed, Capacity
Manager removes the corresponding performance-analysis monitor from the
monitor list once every 24 hours or whenever the Capacity Manager Agent is
restarted.

Note: Performance analysis is available for managed systems running a Windows
or Linux operating system only.

Performance bottlenecks

This concept describes performance bottlenecks.

When you schedule Capacity Manager to check periodically for bottlenecks, or
when you select to generate a report, the performance-analysis function looks for
bottlenecks in managed-system hardware performance. When one or more
performance-analysis monitors meet or exceed their preset threshold settings and
you have selected the Generate Bottleneck events check box when you defined
the report, a bottleneck event is generated. You can adjust the threshold settings on
performance-analysis monitors, but you cannot change the default settings without
impairing the performance-analysis function.

Corresponding to each types of performance-analysis monitors are the four types
of bottlenecks:

* Processor

* Memory

* Disk

¢ LAN adapter

If a bottleneck is detected, two things happen:

* Each managed system with a bottleneck generates an event, and the event is
displayed in the IBM Director event log.

* Areport is generated and saved in the IBM\Director\reports directory (unless
you specify another directory in the report definition).

When the performance-analysis function detects a bottleneck, it diagnoses the
problem and determines a potential solution. The performance-analysis section of
the report details the problem and recommendations.

Multiple bottlenecks can occur. For example, a disk bottleneck and a memory
bottleneck can occur concurrently. In this case, the performance-analysis algorithm
recognizes that insufficient memory can lead to disk thrashing, so the
recommendation is to add more memory and leave the disk drives unchanged.
Because systems and devices often interact in this way, each combination of
bottlenecks (that is, microprocessor, memory, disk, and LAN adapter) constitutes a
separate bottleneck with its own recommendation.

Often, when one bottleneck occurs, other bottlenecks are not evident because the
first bottleneck slows the system. A latent bottleneck is one that is not evident even
though the system has slowed down. Performance analysis reports a managed
system or device as having a latent bottleneck if a performance monitor for that
system or device exceeds the warning threshold at least 50% of the time that the
performance monitor for another system or device is constrained.

Performance-analysis reports

This concept describes the performance-analysis reports.
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When you create a report, you specify a report definition. A report definition
identifies the details that you want to include in the report. You can create a
customized report definition or use a predefine report definition. These predefined
report definitions are included in Capacity Manager:

* Daily report to viewer

* Hourly bottleneck events to file

* Hourly report to viewer

* Monthly report to file

* Weekly report to file

You can generate a report for immediate viewing, or you can save the report to a
file for later viewing.

Reports viewed from the Report Viewer window

The performance-analysis report consists of two sections:

Recommendations
Shows only the subset of details on which you have to act.

Details
Shows everything that was found and contains links so you can see a
graph of the performance of the monitor in question.

The managed systems with the most severe bottlenecks appear at the top of the
report list. A bottleneck that is reported in the Details section is displayed in the
Recommendations section if it meets one of these criteria:

* It occurred on the last day of the report.

* It occurred more than 25% of the time, and it occurred more than any other
bottleneck on that managed system.

¢ It has a high probability of occurring in the future. However, performance
analysis must have enough data to make a reliable forecast.

Reports viewed from a saved HTML file

A report that is saved in HTML contains the following sections:

Table of Contents
Contains links to the other sections.

Report Table
Presents the same monitor and managed-system data that is also available
in the Report Viewer in the Table view.

Report Information
Includes the file name, analysis start and end dates, days of the week and
hours of coverage, name of the report definition, and a list of any managed
systems that were requested but not included in the report.

Performance Analysis recommendations
Recommends remedies for the most serious bottlenecks.

Performance Analysis details
Includes information about the frequency and duration of both active and
latent bottlenecks and their remedies.

Performance forecast
This concept describes how Capacity Manager predicts future performance.

Chapter 1. Getting started 5
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Using the Forecast function of Capacity Manager, you can review a prediction of
future performance of selected managed systems. Capacity Manager uses
forecasting in these interfaces:

* In the performance-analysis section of a report. If there are no realized
bottlenecks, Capacity Manager uses forecasting to predict, with a level of
confidence, if and when it foresees a monitor performance bottleneck.

* In a managed-system monitor performance graph. On a graph of a selected
monitor for one or more managed systems, you can click Forecast icon (& ) to
see a forecast of the performance on the selected managed systems. The graph
depicts both the observed data and the forecast.

To calculate future performance, Capacity Manager applies a wavelet transform to
the monitor data before performing a least-squares linear regression . With this
transformed data, it computes a forecast line with a 95% prediction interval. The
forecast duration is equal to the duration of the observed data.

Tip: For the forecast to be valid, Capacity Manager must have a minimum of 24
days of previously collected data where the managed-system monitors have
been running at least 50% of the time.

Performance forecast graph

The forecast line describes possible future data values that are consistent with the
prediction that an actual future data value will fall within equal probability above
or below the forecast line. This line is a dashed line with an arrow at the end.

The forecast duration is equal to your data-collection period. For example, if you
have a month of collected data, the forecast will be for a month into the future.

The prediction interval is represented by the dotted lines above and below the
forecast line. The prediction interval represents the range of data values that are
located above and below the forecast line and are consistent with the prediction
that an actual future data value will fall within the interval with a probability of
95%. The width of the interval depends on the variability of the observed monitor
data: the greater the variability, the wider the prediction interval. The prediction
interval is displayed when you request a forecast of a single managed system.
Graphs of multiple managed-system forecasts do not show prediction intervals.

If you do not know how to interpret a wide prediction interval for a forecast, select
a finer resolution of your data from the Resolution drop-down list located in the
lower-right corner of the Graph pane. Your data points might have a broad
variance that is hidden by averaging that occurs when data is displayed at a
coarser resolution.

Notes:
1. The vertical bar at the beginning of the forecast data depicts the range.

2. The gap between the actual collected data and the beginning of the
predicted data serves as a separator between these two data sets.
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Chapter 2. Installing Capacity Manager

This topic describes the general procedure for installing the Capacity Manager

extension for IBM Director.

Capacity Manager may be installed on both Windows and Linux platforms.
Installing Capacity Manager is performed in several steps, each of which is

described in a topic in this section.

1. Install Capacity Manager on the management server.

Option

Description

Windows server

“Installing Capacity Manager on a Windows|

server’]

Linux server

“Installing Capacity Manager on a Linux|
server” on page §f

2. Optional: Install Capacity Manager user-interface components for IBM Director
Console on remote management consoles.

Option

Description

Windows console

“Installing Capacity Manager on a Windows|
console” on page 9

Linux console

“Installing Capacity Manager on a Linux]
console” on page 10|

Note: Capacity Manager user-interface components for IBM Director Console
are automatically installed on the management server when the Capacity
Manager server components are installed. It is not necessary or possible
to separately install Capacity Manager console components on a

management server.

3. Install Capacity Manager components for IBM Director Agent on managed

systems.

Option

Description

Windows systems

“Installing Capacity Manager on a managed|
Windows system” on page 11|

Linux systems (32-bit)

“Installing Capacity Manager on a managed|
32-bit Linux system” on page 11|

Note: Capacity Manager agent components are automatically installed on the
management server when the Capacity Manager server components are
installed. It is not necessary or possible to separately install Capacity
Manager agent components on a management server.

Installing Capacity Manager on a Windows server

This topic describes installation procedures for Capacity Manager on a Windows

management server.
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Complete the following steps to install Capacity Manager on a Windows

management server:

1. Close all applications, including any command-prompt windows.

2. Insert the IBM Director 5.10 Capacity Manager CD into the CD-ROM drive.

3. Click Start » Run.

4. In the Run dialog, type the following command in the Open field and press
Enter:

d:\capmgt\server\windows\i386\setup.exe

d represents the drive letter of the CD-ROM drive.

5. In the first panel of the IBM Director Capacity Manager Server Tool
InstallShield Wizard, click Next.

6. In the second panel of the IBM Director Capacity Manager Server Tool
InstallShield Wizard, select I accept the terms in the license agreement, and
click Next.

7. In the third panel of the IBM Director Capacity Manager Server Tool
InstallShield Wizard, click Install. A new panel displays the installation
progress.

8. When installation has completed, click Finish.
9. Remove the CD from the CD-ROM drive.

The installation process automatically stops and restarts the management server.
The IBM Director Capacity Manager Server Tool InstallShield Wizard installs the
server, console, and agent components of Capacity Manager on the management
server.

After installing the server, console, and agent components of Capacity Manager on
the management server, you need to install the console components on any other
management consoles, and the agent components on managed systems.

Installing Capacity Manager on a Linux server

8

This topic describes installation procedures for Capacity Manager on a Linux
management server.

Complete the following steps to install Capacity Manager on a Linux management
server:

1. Stop IBM Director Agent. From a command prompt, type the following
command and press Enter:

/opt/ibm/director/bin/twgstop
2. Insert the IBM Director 5.10 Capacity Manager CD into the CD-ROM drive.

3. If the CD does not automount, mount the CD-ROM drive. Type the following
command and press Enter:

mount /dev/cdrom /mnt/cdrom

For this command and others in this topic, mnt/cdrom is the mount point of the
CD-ROM drive and dev/cdrom is the specific device file for the CD-ROM block
device.

4. Change to the directory in which the installation package is located. Type the
following command and press Enter:

cd /mnt/cdrom/capmgt/server/1inux/i386/

IBM Director Capacity Manager Installation and User’s Guide



5. Type one of the following commands and press Enter:

Installation scenario Command
Performing a new rpm -ivhCapMgtServer-5.10-1.1386.rpm
installation

Upgrading from a previous |rpm -Uvh --relocate
version /opt/ibm/director=/opt/IBM/director
CapMgtServer-5.10-1.1386.rpm

The installation progress is displayed.

6. Restart IBM Director Agent. From a command prompt, type the following
command and press Enter:

/opt/ibm/director/bin/twgstart

7. Unmount the CD-ROM drive. Perform the following steps to unmount the
CD-ROM drive:

a. Type cd / and press Enter.
b. Type the following command and press Enter:
umount /mnt/cdrom
8. Remove the CD from the CD-ROM drive.

The IBM Director Capacity Manager Server installation process installs the server,
console, and agent components of Capacity Manager on the management server.

After installing the server, console, and agent components of Capacity Manager on
the management server, you need to install the console components on any other
management consoles, and the agent components on managed systems.

Installing Capacity Manager on a Windows console

This topic describes installation procedures for Capacity Manager on a Windows
management console.

Capacity Manager server components should be installed on the management
server before installing the console components of Capacity Manager.

Complete the following steps to install Capacity Manager on a Windows
management console:

Close IBM Director Console.
Insert the IBM Director 5.10 Capacity Manager CD into the CD-ROM drive.
Click Start » Run.

In the Run dialog, type the following command in the Open field and press
Enter:

oD~

d:\capmgt\console\windows\i386\setup.exe

d represents the drive letter of the CD-ROM drive.

5. In the first panel of the IBM Director Capacity Manager Console Tool
InstallShield Wizard, click Next.

6. In the second panel of the IBM Director Capacity Manager Console Tool
InstallShield Wizard, select I accept the terms in the license agreement, and
then click Next.
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7. In the third panel of the IBM Director Capacity Manager Console Tool
InstallShield Wizard, click Install. A new panel displays the installation
progress.

8. When installation has completed, click Finish.
9. Remove the CD from the CD-ROM drive.
10. Restart IBM Director Console.

After installing the console components of Capacity Manager, you need to install
the Capacity Manager agent components on your managed systems.

Installing Capacity Manager on a Linux console

This topic describes installation procedures for Capacity Manager on a Linux
management console.

Capacity Manager server components should be installed on the management
server before installing the console components of Capacity Manager.

Note: Capacity Manager user-interface components for IBM Director Console are
automatically installed on the management server when the Capacity
Manager server components are installed. It is not necessary or possible to
separately install Capacity Manager console components on a management
server.

Complete the following steps to install Capacity Manager on a remote Linux
console:

1. Close IBM Director Console.
2. Insert the IBM Director 5.10 Capacity Manager CD into the CD-ROM drive.

3. If the CD does not automount, mount the CD-ROM drive. Type the following
command and press Enter:

mount /dev/cdrom /mnt/cdrom

For this command and others in this topic, mnt/cdrom is the mount point of the
CD-ROM drive and dev/cdrom is the specific device file for the CD-ROM block
device.

4. Change to the directory in which the installation package is located. Type the
following command and press Enter:

cd /mnt/cdrom/capmgt/console/1inux/i386/
5. Type one of the following commands and press Enter:

Installation scenario Command
Performing a new rpm -ivh CapMgtConsole-5.10-1.7386.rpm
installation

Upgrading from a previous |rpm -Uvh --relocate
version /opt/ibm/director=/opt/IBM/director
CapMgtConsole-5.10-1.1386.rpm

The installation progress is displayed.

6. Unmount the CD-ROM drive. Perform the following steps to unmount the
CD-ROM drive:

a. Type cd / and press Enter.
b. Type the following command and press Enter:
umount /mnt/cdrom
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7. Remove the CD from the CD-ROM drive.
8. Restart IBM Director Console.

After installing the console components of Capacity Manager, you need to install
the Capacity Manager agent components on your managed systems.

Installing Capacity Manager on a managed Windows system

This topic describes installation procedures for Capacity Manager on a Windows
managed system.

Capacity Manager should be installed on the management server and management
console before installing the agent components of Capacity Manager on managed
systems.

Note: An alternative installation method is to use Update Assistant and Software
Distribution. For more information, refer to the "Creating software packages
to distribute” section of the IBM Director Systems Management Guide.

Complete the following steps to install Capacity Manager on a Windows managed
system:

1. Insert the IBM Director 5.10 Capacity Manager CD into the CD-ROM drive.
2. Click Start » Run.

3. In the Run dialog, type the following command in the Open field and press
Enter:

d:\capmgt\agent\windows\i386\setup.exe

d represents the drive letter of the CD-ROM drive.

4. In the first panel of the IBM Director Capacity Manager Console Tool
InstallShield Wizard, click Next.

5. In the second panel of the IBM Director Capacity Manager Console Tool

InstallShield Wizard, select I accept the terms in the license agreement, and
then click Next.

6. In the third panel of the IBM Director Capacity Manager Agent Tool
InstallShield Wizard, click Install. A new panel displays the installation
progress.

7. When installation has completed, click Finish.
8. Remove the CD from the CD-ROM drive.

Although you may manually stop and restart IBM Director Agent on the managed
system, it is not necessary to do so for this installation. The listener is stopped
automatically during installation and restarted when installation is complete.

Installing Capacity Manager on a managed 32-bit Linux system

This topic describes installation procedures for Capacity Manager on a 32-bit Linux
managed system.

Capacity Manager should be installed on the management server and management
console before installing the agent components of Capacity Manager on managed

systems.

Notes:
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1. Capacity Manager agent components are automatically installed on the
management server when the Capacity Manager server components are
installed. It is not necessary or possible to separately install Capacity
Manager agent components on a management server.

2. An alternative installation method is to use Update Assistant and
Software Distribution. For more information, refer to the "Creating
software packages to distribute” section of the IBM Director Systems
Management Guide.

Complete the following steps to install Capacity Manager on a 32-bit Linux
managed system:

1. Insert the IBM Director 5.10 Capacity Manager CD into the CD-ROM drive.

2. If the CD does not automount, mount the CD-ROM drive. Type the following
command and press Enter:
mount /dev/cdrom /mnt/cdrom
For this command and others in this topic, mnt/cdrom is the mount point of the
CD-ROM drive and dev/cdrom is the specific device file for the CD-ROM block
device.

3. Stop IBM Director Agent. From a command prompt, type the following
command and press Enter:
/opt/ibm/director/bin/twgstop

4. Change to the directory in which the installation package is located. Type the
following command and press Enter:
cd /mnt/cdrom/capmgt/agent/1inux/i386/

5. Type one of the following commands and press Enter:

Installation scenario Command

Performing a new rpm -ivhCapMgtAgent-5.10-1.7386.rpm

installation

Upgrading from a previous |rpm -Uvh --relocate
version /opt/ibm/director=/opt/IBM/director

CapMgtAgent-5.10-1.1386.rpm

8.

The installation progress is displayed.

Restart IBM Director Agent. From a command prompt, type the following
command and press Enter:

/opt/ibm/director/bin/twgstart

Unmount the CD-ROM drive. Perform the following steps to unmount the
CD-ROM drive:

a. Type cd / and press Enter.
b. Type the following command and press Enter:

umount /mnt/cdrom
Remove the CD from the CD-ROM drive.
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Chapter 3. Monitoring performance

Use the Capacity Manager task to monitor performance across your systems. You
can generate reports and graphs for performance data.

Activating a performance monitor

This task describes how to activate a performance monitor.

Tip: You cannot select a group of monitors by clicking the group name. You must
select each monitor individually. If you have deactivated a monitor, it will not
be reactivated until you reactivate it.

Complete these steps to activate a monitor:
1. In the IBM Director Console Tasks pane, expand the Capacity Manager task.

2. Drag the Monitor Activator subtask onto a managed system or group on which
the Capacity Manager Agent is installed.

3. In the left pane of the Monitor Activator window;, click the monitor that you
want to activate.

4. Click On.
5. Click Apply.

Changing performance-analysis report settings

This task describes how to change the performance-analysis settings.

Complete these steps to change the performance-analysis report settings:
1. In the Report Viewer window, click Edit icon (g ) > Settings.

2. In the Settings window, click the Graph tab to configure the appearance of the
graph in the Graph pane.

Click the Window tab to configure the appearance of the viewer.

Click the Monitors tab to configure the threshold settings for each monitor.
Click Apply.

Click OK.

o o~ W

Changing the graph display settings

This task describes how to configure the graph display settings in the Report
Viewer window.

Complete these steps to configure display options for the graphs in a report:
1. In the Report Viewer window, click the Graph tab.

2. Type the maximum number of systems to display on the graph before
combining results into a trend in the Trend graph field.

3. Type the dimensions of the grid size in the Maximum grid size fields.

4. Select the appropriate graph options from the Graph options box, including
those for displaying maximum and minimum lines for averaged values,
displaying the legend on the screen, and setting the thickness of threshold lines.

5. If you decide to return to the default settings, click Return to defaults.
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Changing the monitor display settings

This task describes how to configure the monitor display settings in the Report
Viewer window.

Complete these steps to configure monitor settings in a report:

1.
2.
3.

6.

From the Report Viewer window, click the Monitors tab.
On the Monitors page, click a monitor in the left pane to select it.

Optional: You can adjust the threshold settings on performance-analysis
monitors to conduct resource planning to discover whether a bottleneck
appears when capacity is set to a given value. However, changing the default
settings will impair the performance-analysis function. If you want to adjust the
threshold settings, type custom values for the warning threshold and critical
threshold settings in the Threshold settings fields.

Select the Show thresholds as a percent of maximum value check box to
display thresholds as a percentage of the maximum value on the report.

Select the Adjust range to peak value check box to set the peak value that is
reported as the vertical range value of the graph.

If you decide to return to the default settings, click Return to defaults.

Changing the report window display settings

This task describes how to configure the window display settings in the Report
Viewer window.

Complete these steps to configure the window display settings for the Report
Viewer window:

1.
2.

In the Report Viewer window, click the Windows tab.

Decide whether to abbreviate column headings. If you choose to abbreviate
column headings, type the maximum number of characters in the field.

Select Small icons or Large icons.
If you decide to return to the default settings, click Return to defaults.

Creating an event filter for bottlenecks

14

This task describes how to create an event filter for bottlenecks.

Complete the following steps to create an event filter specifically for bottlenecks:

1.
2.

—_ -k

oo 0N g A

In IBM Director Console, click Tasks » Event Action Plan Builder.

In the Event Action Plan Builder window;, click File > New » Simple Event
Filter.

In the left pane of the Event Type page in the Simple Event Filter Builder
window, clear the Any check box.

In the right pane, expand Capacity Manager.

Expand Bottleneck.

Click Recommendation.

Click the Extended Attributes tab.

Clear the Any check box.

In the Keywords list, click Hours since bottleneck first started.
In the Operator list, click Equal to.

In the Values field, type 2.
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12. Click File » Save As.
13. In the Save Event Filter window, type the name of the filter.

14. Click OK to save the filter. The new filter is displayed in the Event Filters
pane under Simple Event Filter.

Creating a performance-analysis report

This task describes how to create a performance-analysis report using a predefined
or customized report definition.

To create a report using a predefined or customized report definition:
1. In the IBM Director Console Tasks pane, expand Capacity Manager.
2. Expand Report Generator.

3. Drag the report definition that you want to use onto one or more managed
systems or group. A status window opens to indicate the progress. If the report
definition specifies that the report is sent to the report viewer, the Report
Viewer window opens. If the report definition specifies that the report is sent to
a file, the report is saved automatically. Unless you specify a directory in the
report definition, the file is saved to the default directory,
IBM\Director\reports..

4. If you selected a report definition that is saved to a file, specify one of these
options:
¢ Click Execute Now to generate the report now. A status window opens to

indicate progress. The report is saved to the directory specified in the report
definition or to the default directory, \IBM\Director\reports.

* Click Schedule to set a time to generate the report.

If the report definition specifies that the report is to be displayed in the report
viewer, the Report Viewer window opens.

Creating a performance-analysis report definition

After you create a customized report definition, you can generate a
performance-analysis report that includes only those parameters that you have
specified.

Complete these steps to create a new performance-analysis report definition:

1. Run the Monitor Activator subtask on a managed system or group to activate
the monitors for that system or group.

2. Expand Report Generator

w

Double-click New Report Definition.
4. In the Report Definitions window, specify the report parameters:
a. Click the Report Parameters tab.

b. Select the report duration, the global sampling frequency, and whether to
collect minimum and maximum values.

Note: Selecting the Collect min and max values check box specifies that the
minimum and maximum data points for each sample are collected.
An advantage of collecting the minimum and maximum data points
is that you can use a slower sampling frequency, which collects data
less frequently; using this option reduces the size of the report while
still providing informative managed-system performance data. If
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C.

d.

memory usage is an issue, consider using a slower sampling
frequency. Note that the average is always collected.

Select number of minutes Capacity Manager waits for a system to respond
before considering the system unable to provide the data from the Timeout
per system drop-down list.

Click New. In the New Time Interval window, specify the time of the
report.

5. Specify the methods you want to use to generate the report:

a.
b.
c.

=

Click the Method of Generating a Report tab.
Select Generate to Viewer or Generate to File.

Select the appropriate file-format check boxes to generate the file in the
selected formats. The default file format is XML.

If you selected Generate to SQL, type the database Web address and root
table name in the applicable fields.

Note: The ability to generate a report in SQL format is available on a
Window platform only.

If you use SQL authentication, type the user ID and password for the SQL
connection in the applicable fields.

Select Generate Bottleneck events to generate an event in the IBM Director
event log.

Select Back up existing files to archive saved reports.
Select Number of backups to set the number of reports to keep.
Select Set destination directory to set the destination directory.

Note: The default destination directory is IBM\Director\reports.

6. Specify the monitor selection:

a.
b.

Click the Monitor Selection tab.

On the Monitor Selection page, click Include all activated monitors to
include all active monitors in the report, or click Select individual monitors
to select specific monitors.

If you chose to set individual monitors:
1) Click the appropriate monitors in the Monitors list.
2) Click Include or Exclude to include or exclude the selected monitors.

Select the Override global settings check box to use a different sampling
frequency than the default.

7. Specify the thresholds:

a.

~o oo o

Click the Threshold Settings tab.

Note: A threshold setting applies to all managed systems included in the
report definition.

In the Critical threshold field, type the value of the critical threshold.

In the Warning threshold field, type the value of the warning threshold.
Click Return to defaults to set the threshold values to default values.

Click Save As.

In the Save As window, type the name of the report definition and click OK.

IBM Director Capacity Manager Installation and User’s Guide



Deactivating a performance monitor

This task describes how to deactivate a performance monitor.

Note: You cannot select a group of monitors by clicking the group name. You must
select each monitor individually. If you have deactivated a monitor, it will
not be reactivated until you reactivate it.

Complete these steps to deactivate a performance monitor:
1. In the IBM Director Console Tasks pane, expand the Capacity Manager task.

2. Drag the Monitor Activator subtask onto a managed system or group on which
the Capacity Manager Agent is installed.

3. In the left pane of the Monitor Activator window, click the monitor that you
want to deactivate.

4. Click Off.
5. Click Apply to close the Monitor Activator window.

Identifying bottlenecks

This task describes how to identify bottlenecks in a managed system or group.

Use one of the following methods to identify bottlenecks in a managed system or

group:

* Schedule performance analysis to check for bottlenecks and generate an event
when a threshold is exceeded or met.

* Use the Report Generator function to generate a report immediately.

If a bottleneck is found, the monitor name is shown in bold and in red in the
performance-analysis section of the report, and recommendations for correcting the
bottleneck are made. If no bottleneck is found, the performance-analysis icon
indicates that no bottlenecks were found.

Printing a performance-analysis report

This task describes how to print a performance-analysis summary and graph.

Perform one of the following procedures to print either a performance-analysis
summary or a graph:

* To print a performance-analysis summary, in the Report Viewer window, click
the File icon ({§) ~ Print > Performance analysis report

* To print a performance-analysis graph, in the Report Viewer window, click the
File icon () » Print » Graph Print

Saving a performance-analysis report

This task describes how to save a performance-analysis summary and graph.

You can save a performance-analysis report summary in HTML format for later
viewing and printing from a Web browser. The report in HTML format includes
the monitor and managed-system parameter information from the Table view in
Report Viewer window.
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You can also save a performance-analysis graph in a GIF file. This report includes
the managed-systems information from the Graph pane in the Report Viewer
window.

Complete these steps to save a performance-analysis summary on the
management console as an HTML file:

1. Click File icon ((5) » Export report to local HTML.
2. Type a new file name.
3. In the Export Report to Local HTML window, click Save.

Complete these steps to save a performance-analysis summary on the
management server as an HTML file:

1. Click File icon ((5) » Export report to remote HTML.
2. Type a new file name.
3. In the Export Report to Remote HTML window, click Save.

Complete these steps to save a performance-analysis graph on the management
console as an HTML file:

1. Click File icon () » Export graph to local HTML.
2. Type a new file name.
3. In the Export Graph to Local HTML window, click Save.

Complete these steps to export a performance-analysis graph on the
management server as a GIF file:

1. Click File icon ((5) » Export graph to remote GIF .
2. Type a new file name.
3. In the Export Graph to Remote GIF window, click Save.

Scheduling to check for bottlenecks

18

You can set up a schedule to have IBM Director check for bottlenecks on a regular

ba
Di

sis. When a bottleneck is detected, an event is added to the event log, and IBM
rector generates a report.

You must select the Generate bottleneck events check box for the report definition
that you are using. Otherwise, an event action plan cannot notify you that a

bo
ev

ttleneck has occurred, because event action plans depend on events to trigger
ent actions.

Complete these steps to schedule regular checks for bottlenecks:

1.
2.

N o o s~

In the IBM Director Console Tasks pane, expand the Capacity Manager task.

Expand the Report Generator subtask. Drag Hourly Bottleneck Events onto
the managed system or systems or group that you want to monitor for
bottlenecks.

Click Schedule.

In the New Scheduled Job window, type a job name.

Select the date and time for the initial check.

Click Advanced to schedule the job to repeat at regular intervals.

On the Date/Time page of the New Scheduled Job window, select the Repeat
check box.

In the Repeats group box of the Repeat window, select how often you want to
check for performance bottlenecks.

Click OK.
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10. Click File » Save As.

11. In the Save Job window, type a descriptive name for the scheduled job. Click
OK. A confirmation message is displayed, indicating that you have saved the
job.

12. Click OK to close the message window.

Setting up automatic notification of bottlenecks

This task describes how to sets up automatic notification when bottlenecks occur.

Capacity Manager can determine where and when bottlenecks occur. Complete
these steps to set up automatic notification when a bottleneck occurs:

1. Set up a schedule to periodically check for performance bottlenecks and to
generate an event when a performance threshold is met or exceeded, indicating
a bottleneck.

2. Create an event filter to notify you of the event.
3. Create an event action plan that uses the event filter.

4. Apply the event action plan to the managed systems or groups that you want
to monitor.

Viewing a performance forecast graph

This task describes how to view a performance forecast graph.

To view the forecast graph for a selected managed system, go to the Report Viewer
window. Click the Forecast icon (34 ) in the lower-right corner of the lower-right
pane. Capacity Manager displays the forecast graph for the selected monitor.

Notes:
1. You cannot use the Zoom tool and the Forecast tool at the same time.

2. The forecast data is more meaningful for managed systems that are
individually graphed rather than shown in a trend graph. To change
from a trend graph to a graph of individual managed systems, either
set your trend graph threshold to a higher number or select fewer
managed systems to graph at one time.

Viewing previously generated reports

This task describes how to view reports that were previously generated.

Note: If you use the Report Viewer to display a report that was saved in XML
format, you can adjust the threshold settings on performance-analysis
monitors.

Complete these steps to view a previously generated report:
* To view a report that has been saved to the management server:
1. In the IBM Director Console Tasks pane, expand Capacity Manager.
Right-click Report Viewer.
Click Open.
In the Open Remote Report window, select a file.
5. Click Open.

¢ To view a report that has been saved to the management console:

oD
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In the IBM Director Console Tasks pane, expand Capacity Manager.
Right-click Report Viewer.

Click File icon () » Open local report.

In the Open Local Report window, select a file.

Click Open.

o kw2

Viewing performance statistics

This task describes how to view a performance statistics for active performance
monitors.

In the IBM Director Console Tasks pane, expand the Capacity Manager task. Drag
the Monitor Activator subtask onto a managed system or group on which the
Capacity Manager Agent is installed.

In the left pane, all monitors are displayed in a tree structure; each monitor has an
icon to indicate its status. The names of performance-analysis monitors are
displayed in bold.

In the Systems pane, an icon is displayed beside each managed system or group to
indicate its status. In the Legend pane, the monitor and managed-system icons and
their descriptions are displayed.
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Appendix A. Capacity Manager events

The Capacity Manager events occur when Capacity Manager identifies a managed
system that has a system capacity bottleneck. For the Capacity Manager Agent to

generate these events, you must select the Generate Bottleneck Events check box

when creating a Capacity Manager report definition.

Event source

These event types are generated by the Capacity Manager Agent that is installed
on a Level-2 managed system. A prerequisite for the Capacity Manager Agent is
IBM Director Agent.

Details

If you select the Capacity Manager check box in the Event Filter Builder tree, the
event filter will process all of the event types that are specified in the Capacity
Manager subtree.

Event type Event text Severity Category |Extended attributes
Capacity Not applicable Not Not None
Manager applicable  |applicable

You can choose to select specific event types that are displayed under the Capacity
Manager node in the Event Filter Builder tree. The event filter will process only the
event types that you select.

Event type Event text Severity |Category |Extended attributes
Bottleneck A system bottleneck has Critical | Alert + CMR file indicates that the Capacity
been detected. Manager report is generated in the CMR
format.

* CMS file indicates that the Capacity
Manager report is generated in the CMS
format.

* Cluster node indicates that a Capacity
Manager report is generated about the
Level-2 managed systems that are in a
Microsoft cluster.
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Event type

Event text

Severity

Category

Extended attributes

Bottleneck
(continued)

Days until bottleneck starts indicates the
number of days until the predicted
bottleneck will start.

HTML file indicates that the Capacity
Manager report is generated in the HTML
format.

Hours until bottleneck starts indicates the
number of hours until the predicted
bottleneck will start.

Involves CPUs indicates that the predicted
bottleneck involves the system
microprocessor.

Involves Disks indicates that the predicted
bottleneck involves the system hard disk
drives.

Involves LAN Adapters indicates that the
predicted bottleneck involves the system
LAN adapter.

Involves Memory indicates that the
predicted bottleneck involves the system
memory.

Minutes until bottleneck starts indicates the

number of minutes until the predicted
bottleneck will start.

TXT file indicates that the Capacity
Manager report is generated in the ASCII
text format.

XML file indicates that the Capacity
Manager report is generated in the XML
format.

Bottleneck >
Recommendation

An event-enabled Capacity
Manager report has been
run and a system
bottleneck was detected
during performance
analysis.

Critical

Alert

CMR file indicates that the Capacity
Manager report is generated in the CMR
format.

CMS file indicates that the Capacity
Manager report is generated in the CMS
format.

Cluster node indicates that a Capacity
Manager report is generated about the
Level-2 managed systems that are in a
Microsoft cluster.
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Event type

Event text

Severity

Category

Extended attributes

Bottleneck >
Recommendation
(continued)

Days since bottleneck first started indicates
the number of days since the bottleneck
started.

Days since bottleneck last stopped indicates
the number of days since the bottleneck
stopped.

Days until bottleneck starts indicates the
number of days until the predicted
bottleneck will start.

HTML file indicates that the Capacity
Manager report is generated in the HTML
format.

Hours in this bottleneck indicates the number
of hours in this bottleneck occurrence.

Hours since bottleneck first started indicates
the number of hours since the bottleneck
started.

Hours since bottleneck last stopped indicates
the number of hours since the bottleneck
stopped.

Hours until bottleneck starts indicates the
number of hours until the predicted
bottleneck will start.

Involves CPUs indicates that the predicted
bottleneck involves the system
microprocessor.

Involves Disks indicates that the predicted
bottleneck involves the system hard disk
drives.

Involves LAN Adapters indicates that the
predicted bottleneck involves the system
LAN adapter.

Involves Memory indicates that the predicted
bottleneck involves the system memory.

Minutes since bottleneck first started indicates
the number of minutes since the bottleneck
started.

Minutes since bottleneck last stopped indicates
the number of minutes since the bottleneck
stopped.

Minutes until bottleneck starts indicates the

number of minutes until the predicted
bottleneck will start.
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Event type Event text Severity | Category | Extended attributes
Bottleneck > « TXT file indicates that the Capacity
Recommendation Manager report is generated in the ASCII
(continued) text format.
* When bottleneck first started indicates the
time when the bottleneck started.
* When bottleneck last stopped indicates the
time when the bottleneck stopped.
* XML file indicates that the Capacity
Manager report is generated in the XML
format.
No Response Not applicable Minor Alert None
No Response > No systems responded Minor Alert None

No Monitors

with monitor data when
an event-enabled report
was run.

24 IBM Director Capacity Manager Installation and User’s Guide




Appendix B. Capacity Manager windows

Monitor Activator window

This topic describes the Monitor Activator window in IBM Director.
Introduction

The Monitor Activator windows shows which resource monitors are currently
active on a managed system or group. It also allows you to activate and deactivate
monitors on a managed system.

Fields

Tree structure
All monitors displayed in a tree structure. Each monitor has an icon to
indicate its status. The names of performance-analysis monitors are

displayed in bold.
On Activates the selected monitor.

Off Deactivates the selected monitor. The monitor is not reactivated
until you reactivate it.

Systems
Displays the status of each managed system for the selected monitors. An
icon beside each managed system or group indicates its status.

Legend
Displays the monitor and managed-system icons and their descriptions.

Report Definitions window

This topic describes the Report Definitions window in IBM Director.
Introduction

Use report definition to decide what data to collect and how often, when to
generate the report, how the report will be named and saved, and whether to view
it now or later. Capacity Manager provides five standard report definitions:
Hourly, Daily, Weekly, Monthly, and Hourly Bottleneck Events.

Report Definition window: Report Parameters page

This topic describes the Report Definition window: Report Parameters page in IBM
Director.

Fields

Use the Report Definition window to set the following parameters for all of your
monitors.

Report Duration
The length of time covered by the report. A standard report definition will
already have this set. For example, the Weekly report definition will have
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this set to 1 week. If you are creating a new report definition, the possible
report durations are 3 hours, 8 hours, 1 day, 1 week, and 1 month.

Global Sampling Frequency
Selects how often sampling occurs for all of the selected monitors.
Sampling frequency values are 1 minute, 5 minutes, 30 minutes, and 1
hour.

Collect min and max values
The minimum and maximum data values for the collection.

Timeout per System
Selects how long Capacity Manager waits for each of your selected systems
to respond. Values for this field can be 1 - 9 minutes.

Days Selects the days of the week collection occurs.

Times Selects the new data-collection time interval. This field also edits an
existing one-time interval or deletes a time interval.

Report Definitions window: Method of Generating Report page

This topic describes the Report Definitions window: Method of Generating Report
page in IBM Director.

Fields

Append time stamp to file name
When checked, creates a unique file name by adding a time stamp to the
file name.

Generate to Viewer
Generates a report to the Report Viewer for immediate viewing.

Generate to File
Saves the report to a directory. The file can be saved in the following file

types:
* .cmr
° ixt
e html
* .xml

e .cms (Generate to SQL option)

Generate to SQL
The file is saved to a new SQL table or appended to an existing
SQL table.

Append
When checked, the report is appended to an existing SQL
table.

Database URL
Specifies the database to connect to.

Root table name
Specifies the name of the table to write to.

User ID
Specifies the user ID for access to the database.

Password
Specifies the password associated with the password.
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Backup up existing files
When selected, renames any existing reports with a dot and
number. For example Hourly Report.comr becomes Hourly
Report.cmr.1,

Number of backups
Limits the number of backups to the selected number. Backups
earlier than this number are deleted.

Set destination directory
Saves all selected file types to the selected destination directory on
the IBM Director Server.

Generate Bottleneck events
Writes the files only when bottlenecks occur.

Report Definitions window: Monitor Selection page

This topic describes the Report Definitions window: Monitor Selection page in IBM
Director.

Fields

Include all active monitors
Specifies that all the monitors activated in the Monitor Activator window
have the global sampling frequency that is set in the Report Parameters
window

Include all individual monitors
Specifies which monitors to include in the report among those that are
activated in the Monitor Activator window.

Monitors
The list of monitors to specify.

Tree  When checked, displays a tree view of the monitors.

Include button
The selected monitor is included in the report.

Exclude button
The selected monitor is excluded from the report.

Global settings
The current global settings for all of the monitors.

Override global settings
When checked, the global settings do apply to the selected monitor.

Sampling frequency
The sampling frequency for the selected monitor. Sampling
frequency values are 1 minute, 5 minutes, 30 minutes, and 1 hour.

Collect Min and Max values
The collection minimum and maximum data values for the selected
monitor.

Report Definitions window: Threshold settings page

This topic describes the Report Definitions window: Threshold settings page in
IBM Director.
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Fields

Monitors
The monitor for which to set the values specified in the Threshold settings
field.

Threshold settings
Sets the Critical threshold and Warning thresholds for a selected monitor.
The thresholds are a percentage of the actual value of the monitor when
set on a Report Definition.

Report Viewer window

This topic describes the Report Viewer window in IBM Director.

Toolbars

File menu >
Use the File menu to work with report files.

Open local report
Opens a report file located on your workstation.

Merge with local report
Combines one or more report files that are stored on your
workstation with the report file that is currently open in the Report
Viewer.

Save as local report
Saves the report on your workstation.

Export report to local HTML
Saves the report as an .html file on your workstation.

Export graph to local GIF
Saves the graph that is currently shown in the Report Viewer as a
.gif file on your workstation.

Open remote report
Opens a report that is saved on the IBM Director server.

Merge with remote report
Combines one or more report files that are stored on the IBM
Director server with the report file that is currently open in the
Report Viewer.

Save as remote report
Saves the report on the IBM Director server.

Export report to remote HTML
Saves the report as an .html file on the IBM Director server.

Export graph to remote GIF
Saves the graph that is currently shown in the Report Viewer as a
.gif file on the IBM Director server

Print >
Prints the graph or performance analysis report.

Graph Print
Prints graph information from the Report Viewer.

Performance Analysis Report
Prints the Performance Analysis report.
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New Window
Opens the Report Viewer in a new window.

Exit  Closes the Report Viewer.

Edit menu >
Use the Edit menu to changes settings, select all systems, or use the
Enable Performance Analysis option.

Select all systems
Selects all systems listed in the system pane of the Report Viewer

Settings
Changes the appearance of the Report Viewer.

Table view of systems
Displays the view of systems or groupings in a table.

Icon view of systems
Displays all of the systems or groupings as icons on one panel.

Hypergraph view of systems
Displays the average data values of the selected monitor for all the systems
or clusters and groups in your report.

Performance analysis view of systems
Probes for bottlenecks in server hardware performance, diagnoses the
problem, and suggests ways to improve performance.

System mode
Displays systems individually, regardless of whether they belong to a
cluster or group

Group mode
Displays systems that are grouped together either because they belong to a
particular cluster or because they belonged to an IBM Director group.

Sort by
Allows you to select a field in the System pane to sort in ascending or
descending order.

Fields

System pane
Displays the systems in your report. It has four views to help you evaluate
your systems’ performance.

Monitor pane
Displays the list of monitors in your report in one of two views: the flat
plane view or the tree view.

Graph pane
Displays a graph of the systems selected in the System pane and the
monitor selected in the Monitor pane.
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Appendix C. Operating systems supported by Capacity

Manager

This topic provides information about the operating systems supported by the
Capacity Manager task.

Management-server support

This task is supported by IBM Director Server when installed on servers running
the following operating systems:

* Linux on xSeries

* Windows

Managed-object support

The following tables list the operating systems that this task supports for managed
objects. Managed objects can include IBM xSeries, iSeries , System p5 and pSeries,
and System z9 and zSeries hardware. Managed systems are a subset of managed
objects that use different levels of IBM Director support. This task can be used on
Level-2 managed systems only. These managed systems must be xSeries and
Netfinity servers.

Table 1. Operating systems supported by xSeries servers

Operating system Level 2

Editions of Windows for 32-bit systems:

¢ Windows 2000, Advanced Server, Datacenter, Professional, and Server Yes
Editions

¢ Windows XP Professional Edition
* Windows Server 2003, Datacenter, Enterprise, Standard, and Web Editions

Editions of Windows for 64-bit systems:

* Windows Server 2003, Datacenter, Enterprise, Standard, and Web x64 No
Editions

¢ Windows XP Professional x64 Edition

* Windows Server 2003, Datacenter and Enterprise 64-bit Itanium Editions

Versions of Linux for 32-bit systems:

* Red Hat Enterprise Linux AS, ES, and WS, version 3.0 Yes
* Red Hat Enterprise Linux AS, ES, and WS, version 4.0

» SUSE LINUX Enterprise Server 8 for x86

» SUSE LINUX Enterprise Server 9 for x86

¢ VMware ESX Server, versions 2.1, 2.5, and 2.51, Console

* VMware ESX Server, versions 2.1, 2.5, and 2.51, guest operating systems
¢ VMware GSX Server, versions 3.1 and 3.2, Console

* VMware GSX Server, versions 3.1 and 3.2, guest operating systems

Versions of Linux for 64-bit systems:
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Table 1. Operating systems supported by xSeries servers (continued)

Operating system Level 2
* Red Hat Enterprise Linux AS, ES, and WS, version 3.0, for AMD64 and No
EM64T
* Red Hat Enterprise Linux AS, ES, and WS, version 4.0, for AMD64 and
EM64T

* Red Hat Enterprise Linux AS, version 3.0, for Intel Itanium

* Red Hat Enterprise Linux AS, version 4.0, for Intel Itanium

» SUSE LINUX Enterprise Server 8 for AMD64

» SUSE LINUX Enterprise Server 8 for Itanium Processor Family
» SUSE LINUX Enterprise Server 9 for AMD64 and EM64T

» SUSE LINUX Enterprise Server 9 for Itanium Processor Family

Other operating systems supported by xSeries servers:

Microsoft Virtual Server (guest operating system) Yes

NetWare, version 6.5 Yes

Table 2. Operating systems supported by iSeries servers and System p5 and pSeries

servers
Operating system Level 2
e AIX 5L, Version 5.2 No

e AIX 5L, Version 5.3

e i5/0S, Version 5 Release 3

* Red Hat Enterprise Linux AS, version 3.0, for IBM POWER
Note: System p5 and pSeries servers require Red Hat Enterprise Linux AS,
version 3.3 or later, for IBM POWER

* Red Hat Enterprise Linux AS, version 4.0, for IBM POWER

» SUSE LINUX Enterprise Server 8 for IBM POWER

» SUSE LINUX Enterprise Server 9 for IBM POWER

Table 3. Operating systems supported by System z9 and zSeries servers

Operating system Level 2
* Red Hat Enterprise Linux AS, version 4.0, for IBM System z9, zSeries and No
5/390

» SUSE LINUX Enterprise Server 9 for IBM System z9, zSeries and S/390

32  IBM Director Capacity Manager Installation and User’s Guide



Appendix D. Notices
This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
MWO9A /050

5600 Cottle Road
San Jose, CA 95193
US.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks

The following terms are trademarks of International Business Machines
Corporation in the United States, other countries, or both:

AIX

AIX 5L

Alert on LAN
Asset ID
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BladeCenter

DB2

DB2 Universal Database
DirMaint

Electronic Service Agent
Enterprise Storage Server
eServer

eServer logo

FlashCopy
HiperSockets

i5/0S

IBM

IBM logo

ibm.com

IntelliStation

iSeries

Netfinity

NetServer

NetView

0S/400

POWER

Predictive Failure Analysis
pSeries

RACF

Redbooks

ServeProven

SurePOS

System p5

System z9

Tivoli

Tivoli Enterprise

Tivoli Enterprise Console
Virtualization Engine
Wake on LAN

xSeries

z/VM

zSeries

Intel and Pentium are trademarks of Intel Corporation in the United States, other
countries, or both.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

Linux is a trademark of Linus Torvalds in the United States, other countries, or
both.
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Microsoft, Windows, and Windows NT are trademarks of Microsoft Corporation in
the United States, other countries, or both.

Red Hat and all Red Hat-based trademarks and logos are trademarks or registered
trademarks of Red Hat, Inc., in the United States and other countries.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Other company, product, or service names may be trademarks or service marks of
others.
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Abbreviations, Acronyms, and Glossary

Abbreviation and acronym list

This topic lists abbreviations and acronyms used
in the IBM Director documentation.

Table 4. Abbreviations and acronyms used in IBM

Director documentation

Table 4. Abbreviations and acronyms used in IBM
Director documentation (continued)

Abbreviation or

Abbreviation or

acronym Definition

AES advanced encryption standard

APAR authorized program analysis
report

ASF Alert Standard Format

ASM Advanced System

Management

ASM PCI Adapter

Advanced System
Management PCI Adapter

BIOS basic input/output system

CEC Central Electronics Complex

CIM Common Information Model

CIMOM Common Information Model
Object Manager

CP control program

CRC cyclic redundancy check

CSM IBM Cluster Systems
Management

Csv comma-separated value

DASD direct access storage device

DBCS double-byte character set

DES data encryption standard

DHCP Dynamic Host Configuration
Protocol

DIMM dual inline memory module

DMI Desktop Management
Interface

DMTF Distributed Management Task
Force

DNS Domain Name System

DSA Digital Signature Algorithm

EEPROM electrically erasable
programmable read-only
memory

FRU field-replaceable unit

acronym Definition

FTMI fault tolerant management
interface

FTP file transfer protocol

GB gigabyte

Gb gigabit

GMT Greenwich Mean Time

GUI graphical user interface

GUID globally unique identifier

HMC Hardware Management
Console

HTML hypertext markup language

1Is Microsoft Internet Information
Server

170 input/output

P Internet protocol

1PC interprocess communication

IPMI Intelligent Platform
Management Interface

1PX internetwork packet exchange

ISDN integrated services digital
network

ISMP integrated system
management processor

JVM Java™" Virtual Machine

JCE Java Cryptography Extension

JDBC Java Database Connectivity

JEC Java Foundation Classes

JRE Java Runtime Environment

KB kilobyte

Kb kilobit

kpbs kilobits per second

KVvM keyboard/video/mouse

LAN local area network

LED light-emitting diode

LPAR logical partition

MAC media access control
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Table 4. Abbreviations and acronyms used in IBM
Director documentation (continued)

Table 4. Abbreviations and acronyms used in IBM
Director documentation (continued)

Abbreviation or

Abbreviation or
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acronym Definition acronym Definition
MB megabyte SAS Serial Attached SCSI
Mb megabit SATA Serial ATA
Mbps megabits per second SCSI Small Computer System
MD5 message digest 5 Interface
MDAC Microsoft Data Access Control SFS shared file system
MHz megahertz SHA Secure Hash Algorithm
MIB Management Information SI Solution Install
Base SID (1) security identifier (2)
MIF Management Information Oracle system identifier
Format SLP service location protocol
MMC Microsoft Management SLPD service location protocol
Console daemon
MPA Management Processor SMBIOS System Management BIOS
Assistant SMI System Management
MPCLI Management Processor Information
Command-Line Interface SMP symmetric multiprocessor
MSCS Microsoft Cluster Server SMS Systems Management Server
MST Microsoft sgftware SMTP Simple Mail Transfer Protocol
transformation
ART 1f- itoring, Analysi
NIC network interface card SM ;chﬁ?ﬁét%sﬁﬁolggyym and
NNTP Network News Transfer SMILS Storage Management
Protocol Initiative Specification
NTP network time protocol SNMP Simple Network Management
NVRAM nonvolatile random access Protocol
memory SPB software package block
ODBC Open DataBase Connectivity SQL Structured Query Language
OID object ID SSH Secure Shell
bl Penpheral component SSL Secure Sockets Layer
interconnect
TAP Tel Alph i
OSA Open Systems Adapter Pio(‘zzii)olr phanumeric
PCI-X Petripheral ctomforliergc TCP/IP Transmission Control
1nterconnect-extende Protocol/Internet Protocol
PDF Portable Document Format TTL time to live
PFA Predictive Failure Analysis® UDP User Datagram Protocol
POST power-on self-test UID unique ID
PTF program temporary fix UIM upward integration module
RAM random access memory UNC universal naming convention
RDM Remote Deployment Manager USB Universal Serial Bus
RPM (1) Red Ha.t Package Manager UuUID universal unique identifier
(2) revolutions per minute
RSA Rivest-Shamir-Adleman vPD vital product data
RXE Remote Expansion Enclosure




Table 4. Abbreviations and acronyms used in IBM
Director documentation (continued)

Abbreviation or

acronym Definition

VMRM Virtual Machine Resource
Manager

VRM voltage regulator module

WAN wide area network

WM Wired for Management

WINS Windows Internet Naming
Service

WMI Windows Management
Instrumentation

WQL Windows Management
Instrumentation Query
Language

XML extensible markup language

Glossary

This glossary includes terms and definitions from:

* The American National Dictionary for Information
Systems, ANSI X3.172-1990, copyright 1990 by
the American National Standards Institute
(ANSI). Copies may be purchased from the
American National Standards Institute, 1430
Broadway, New York, New York 10018.
Definitions are identified by the symbol (A)
after the definition.

* The Information Technology Vocabulary developed
by Subcommittee 1, Joint Technical Committee
1, of the International Organization for
Standardization and the International
Electrotechnical Committee (ISO/IEC
JTC1/SC1). Definitions of published parts of
this vocabulary are identified by the symbol (I)
after the definition; definitions taken from draft
international standards, committee drafts, and
working papers being developed by ISO/IEC
JTC1/SC1 are identified by the symbol (T) after
the definition, indicating that final agreement
has not yet been reached among the
participating National Bodies of SC1.

* The IBM Dictionary of Computing, New York:
McGraw-Hill, 1994.

* The IBM Glossary of Computing Terms, 1999.

To view other IBM glossary sources, see IBM
Terminology at [www.ibm.com/ibm/terminology]

A

Advanced Encryption Setting (AES)
A block cipher algorithm, also known as
Rijndael, used to encrypt data transmitted
between managed systems and the
management server, which employs a key
of 128, 192, or 256 bits. AES was
developed as a replacement for DES.

Advanced System Management (ASM)

interconnect
A feature of IBM service processors that
enables users to connect up to 24 servers
to one service processor, thus eliminating
the need for multiple modems,
telephones, and LAN ports. It provides
such out-of-band management functions
as system power control,
service-processor event-log management,
firmware updates, alert notification, and
user profile configuration.

Advanced System Management (ASM)

interconnect network
A network of IBM servers created by
using the ASM interconnect feature. The
servers are connected through RS-485
ports. When servers containing integrated
system management processors (ISMPs)
and ASM processors are connected to an
ASM interconnect network, IBM Director
can manage them out-of-band.

Advanced System Management (ASM) PCI

adapter
An IBM service processor that is built into
the Netfinity 7000 M10 and 8500R servers.
It also was available as an option that
could be installed in a server that
contained an ASM processor. When an
ASM PCI adapter is used with an ASM
processor, the ASM PCI adapter acts as an
Ethernet gateway, while the ASM
processor retains control of the server.
When used as a gateway service
processor, the ASM PCI adapter can
communicate with other ASM PCI
adapters and ASM processors only.

Advanced System Management (ASM)

processor
A service processor built into the
mid-range Netfinity and early xSeries
servers. IBM Director can connect
out-of-band to an ASM processor located
on an ASM interconnect; an ASM PCI
adapter, a Remote Supervisor Adapter, or
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a Remote Supervisor II must serve as the
gateway service processor.

alert A message or other indication that
identifies a problem or an impending
problem.

alert forwarding
Alert forwarding can ensure that alerts
are sent, even if a managed system
experiences a catastrophic failure, such as
an operating-system failure.

alert-forwarding profile
A profile that specifies where remote
alerts for the service processor should be
sent.

alert standard format (ASF)
A specification created by the Distributed
Management Task Force (DMTF) that
defines remote-control and alerting
interfaces that can best serve a client
system in an environment that does not
have an operating system.

anonymous command execution
Execution of commands on a target
system as either system account (for
managed systems running Windows) or
root (for managed systems running
Linux). To restrict anonymous command
execution, disable this feature and always
require a user ID and password.

ASF  See alert standard format.

ASM interconnect gateway
See gateway service processor.

association
(1) A way of displaying the members of a
group in a logical ordering. For example,
the Object Type association displays the
managed objects in a group in folders
based on their type. (2) A way to display
additional information about the members
of the group. For example, the Event
Action Plans association displays any
event action plans applied to the
managed objects in the group in an Event
Action Plan folder.

B

basic input/output system (BIOS)
The code that controls basic hardware
operations, such as interactions with
diskette drives, hard disk drives, and the
keyboard.
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BIOS See Basic Input/Output System.

blade server
An IBM @server BladeCenter server. A
high-throughput, two-way, Intel
Xeon-based server on a card that supports
symmetric multiprocessors {SMP}.

BladeCenter chassis
A BladeCenter unit that acts as an
enclosure. This 7-U modular chassis can
contain up to 14 blade servers. It enables
the individual blade servers to share
resources, such as the management,
switch, power, and blower modules.

bottleneck
A place in the system where contention
for a resource is affecting performance.

Cc

chassis
The metal frame in which various
electronic components are mounted.

chassis detect-and-deploy profile
A profile that IBM Director automatically
applies to all new BladeCenter chassis
when they are discovered. The profile
settings include management module
name, network protocols, and static IP
addresses. If Remote Deployment
Manager (RDM) is installed on the
management server, the chassis
detect-and-deploy profile also can include
deployment policies.

CIM  See Common Information Model.

Common Information Model (CIM)
An implementation-neutral,
object-oriented schema for describing
network management information. The
Distributed Management Task Force
(DMTF) develops and maintains CIM
specifications.

component association
In the IBM Director Rack Manager task, a
function that can make a managed system
or device rack-mountable when the
inventory collection feature of IBM
Director does not recognize the managed
system or device. The function associates
the system or device with a predefined
component.



D

Data Encryption Standard (DES)
A cryptographic algorithm designed to
encrypt and decrypt data using a private
key.

database server
The server on which the database
application and database used with IBM
Director Server are installed.

deployment policy
A policy that associates a specific bay in a
BladeCenter chassis with an RDM
noninteractive task. When a blade server
is added to or replaced in the bay, IBM

Director automatically runs the RDM task.

DES  See Data Encryption Standard.

Desktop Management Interface (DMI)
A protocol-independent set of application
programming interfaces (APIs) that were
defined by the Distributed Management
Task Force (DMTF). These interfaces give
management application programs
standardized access to information about
hardware and software in a system.

Diffie-Hellman key exchange
A public, key-exchange algorithm that is
used for securely establishing a shared
secret over an insecure channel. During
Phase II negotiations, the Diffie-Hellman
group prevents someone who intercepts
your key from deducing future keys that
are based on the one they have.

digital signature algorithm (DSA)
A security protocol that uses a pair of
keys (one public and one private) and a
one-way encryption algorithm to provide
a robust way of authenticating users and
systems. If a public key can successfully
decrypt a digital signature, a user can be
sure that the signature was encrypted
using the private key.

discovery
The process of finding resources within
an enterprise, including finding the new
location of monitored resources that were
moved.

DMI  See Desktop Management Interface.

E

enclosure
A unit that houses the components of a

storage subsystem, such as a control unit,
disk drives, and power source.

event An occurrence of significance to a task or
system, such as the completion or failure
of an operation. There are two types of
events: alert and resolution.

event action
The action that IBM Director takes in
response to a specific event or events.

event-action plan
A user-defined plan that determines how
IBM Director will manage certain events.
An event action plan comprises one or
more event filters and one or more
customized event actions.

event-data substitution variable
A variable that can be used to customize
event-specific text messages for certain
event actions.

event filter
A filter that specifies the event criteria for
an event action plan. Events must meet
the criteria specified in the event filter in
order to be processed by the event action
plan to which the filter is assigned.

extension
See IBM Director extension.

F

field-replaceable unit (FRU)
An assembly that is replaced in its
entirety when any one of its components
fails. In some cases, a FRU may contain
other FRUs.

file-distribution server
In the Software Distribution task, an
intermediate server that is used to
distribute a software package when the
redirected-distribution method is used.

forecast
A function that can provide a prediction
of future performance of a managed
system using past data collected on that
managed system.

FRU  See field-replaceable unit.

G

gateway service processor
A service processor that relays alerts from
service processors on an Advanced
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System Management (ASM) interconnect
network to IBM Director Server.

group A logical set of managed objects. Groups
can be dynamic, static, or task-based.

GUID See Universal Unique Identifier.

IBM Director Agent
A component of IBM Director software.
When IBM Director Agent is installed on
a system, the system can be managed by
IBM Director. IBM Director Agent
transfers data to the management server
using several network protocols,
including TCP/IP, NetBIOS, and IPX.

IBM Director Console
A component of IBM Director software.
When installed on a system, it provides a
graphical user interface (GUI) for
accessing IBM Director Server. IBM
Director Console transfers data to and
from the management server using
TCP/1P.

IBM Director database
The database that contains the data stored
by IBM Director Server.

IBM Director environment
The complex, heterogeneous environment
managed by IBM Director. It includes
systems, BladeCenter chassis, software,
SNMP devices.

IBM Director extension
A tool that extends the functionality of
IBM Director. Some of the IBM Director
extensions are Capacity Manager,
ServeRAID " Manager, Remote
Deployment Manager, Software
Distribution.

IBM Director Server
The main component of IBM Director
software. When installed on the
management server, it provides basic
functions such as discovery of the
managed systems, persistent storage of
configuration and management data, an
inventory database, event listening,
security and authentication, management
console support, and administrative tasks.

IBM Director Server service
A service that runs automatically on the
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management server, and provides the
server engine and application logic for
IBM Director.

IBM Director service account

The Windows operating-system account
associated with the IBM Director Server
service.

in-band communication

Communication that occurs through the
same channels as data transmissions. An
example of in-band communication is the
interprocess communication that occurs
between IBM Director Server, IBM
Director Agent, and IBM Director
Console.

integrated system management processor

(ISMP)

A service processor built into the some
xSeries servers. The successor to the
Advanced System Management (ASM)
processor, the ISMP does not support
in-band communication in systems
running NetWare. For IBM Director
Server to connect out-of-band to an ISMP,
the server containing the ISMP must be
installed on an ASM interconnect
network. A Remote Supervisor Adapter or
a Remote Supervisor Adapter II must
serve as the gateway service processor.

interprocess communication (IPC)

1) The process by which programs
communicate data to each other and
synchronize their activities. Semaphores,
signals, and internal message queues are
common methods of interprocess
communication. 2) A mechanism of an
operating system that allows processes to
communicate with each other within the
same computer or over a network. It also
is called in-band communication

inventory-software dictionary

IPC
ISMP

job

A file that tracks the software installed on
managed systems in a network.

See interprocess communication.

See integrated system management processor.

A separately executable unit of work
defined by a user, and run by a computer.



L

Level-0 managed system
An IBM or non-IBM server, desktop
computer, workstation, or mobile
computer, that can be managed by IBM
Director but does not have any IBM
Director software installed on it.

Level-1 managed system
An IBM or non-IBM server, desktop
computer, workstation, and mobile
computer that has IBM Director Core
Services installed. IBM Director uses IBM
Director Core Services to communicate
with and administer the Level-2 managed
system. IBM Director Core Services
includes the SLP instrumentation, the IBM
Director Agent SLP service type, and
Common Information Model (CIM).

Level-2 managed system
An IBM or non-IBM server, desktop
computer, workstation, or mobile
computer that has IBM Director Agent
installed. IBM Director Agent provides
managed systems with the full
complement of IBM Director Agent
function that is used to communicate with
and administer the Level-2 managed
system. The function of a Level-2
managed system varies depending on the
operating system and platform.

light path diagnostics
A technology that provides a lighted path
to failed or failing components to
expedite hardware repairs.

MAC address
See media access control (MAC) address.

managed group
A group of systems or objects managed
by IBM Director.

managed object
An item managed by IBM Director. In
IBM Director Console, a managed object
is represented by an icon that shows its
type (such as chassis, cluster, system, or
scalable system, for example).

managed object ID
A unique identifier for each managed
object. It is the key value used by IBM
Director database tables.

managed system
A system that is being controlled by a
given system management application, for
example, a system managed by IBM
Director.

management console
A system (server, desktop computer,
workstation, or mobile computer) on
which IBM Director Console is installed.

management module
The BladeCenter component that handles
system-management functions. It
configures the chassis and switch
modules, communicates with the blade
servers and all I/O modules, multiplexes
the keyboard/video/mouse (KVM), and
monitors critical information about the
chassis and blade servers.

management server
The server on which IBM Director Server
is installed.

media access control (MAC) address
In a local area network, the protocol that
determines which device has access to the
transmission medium at a given time.

N

nonvolatile random-access memory (NVRAM)
Random access memory (storage) that
retains its contents after the electrical
power to the machine is shut off.

notification
See alert.

NVRAM
See nonvolatile random-access memory.

(o)

out-of-band communication
Communication that occurs through a
modem or other asynchronous
connection, for example, service processor
alerts sent through a modem or over a
LAN. In an IBM Director environment,
such communication is independent of
the operating system and interprocess
communication (IPC).

P

partition
See scalable partition.

PCI  See Peripheral Component Interconnect.
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PCI-X See Peripheral Component Interconnect-X.

Peripheral Component Interconnect (PCI)
A standard for connecting attached
devices to a computer.

Peripheral Component Interconnect-X (PCI-X)
An enhancement to the Peripheral
Component Interconnect (PCI)
architecture. PCI-X enhances the
Peripheral Component Interconnect (PCI)
standard by doubling the throughput
capability and providing additional
adapter-performance options while
maintaining backward compatibility with
PCI adapters.

PFA  See Predictive Failure Analysis.

physical platform
An IBM Director managed object that
represents a single physical chassis or
server that has been discovered through
the use of the Service Location Protocol
(SLP).

plug-in
A software module, often written by a
third party, that adds function to an
existing program or application such as a
Web browser. See IBM Director extension.

POST See power-on self-test.

power-on self-test
A series of internal diagnostic tests
activated each time the system power is
turned on.

Predictive Failure Analysis (PFA)
A scheduled evaluation of system data
that detects and signals parametric
degradation that might lead to functional
failures.

private key
1) In secure communication, an
algorithmic pattern used to encrypt
messages that only the corresponding
public key can decrypt. The private key is
also used to decrypt messages that were
encrypted by the corresponding public
key. The private key is kept on the user’s
system and is protected by a password. 2)
The secret half of a cryptographic key
pair that is used with a public key
algorithm. Private keys are typically used
to digitally sign data and to decrypt data
that has been encrypted with the
corresponding public key.
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public key
1) In secure communication, an
algorithmic pattern used to decrypt
messages that were encrypted by the
corresponding private key. A public key is
also used to encrypt messages that can be
decrypted only by the corresponding
private key. Users broadcast their public
keys to everyone with whom they must
exchange encrypted messages. 2) The
non-secret half of a cryptographic key
pair that is used with a public key
algorithm. Public keys are typically used
to verify digital signatures or decrypt
data that has been encrypted with the
corresponding private key.

R

redirected distribution
A method of software distribution that
uses a file-distribution server.

remote I/O enclosure
An IBM Director managed object that
represents an expansion enclosure of
Peripheral Component Interconnect-X
(PCI-X) slots, for example, an RXE-100
Remote Expansion Enclosure. The
enclosure consists of one or two
expansion Kkits.

Remote Supervisor Adapter
An IBM service processor. It is built into
some XxSeries servers and available as an
optional adapter for use with others.
When used as a gateway service
processor, the Remote Supervisor Adapter
can communicate with all service
processors on the Advanced System
Management (ASM) interconnect.

resolution
The occurrence of a correction or solution
to a problem.

resource-monitor threshold
The point at which a resource monitor
generates an event.

RXE Expansion Port
The dedicated high-speed port used to
connect a remote I/O expansion unit,
such as the RXE-100 Remote Expansion
Enclosure, to a server.



scalable node

A physical platform that has at least one
SMP Expansion Module. Additional
attributes are assigned to a physical
platform when it is a scalable node. These
additional attributes record the number of
SMP Expansion Modules, SMP Expansion
Ports, and RXE Expansion ports on the
physical chassis.

scalable object

An IBM Director managed object that is
used with Scalable Systems Manager.
Scalable objects include scalable nodes,
scalable systems, scalable partitions, and
remote I/O enclosures that are attached to
scalable nodes.

scalable partition

An IBM Director managed object that
defines the scalable nodes that can run a
single image of the operating system. A
scalable partition has a single, continuous
memory space and access to all associated
adapters. A scalable partition is the logical
equivalent of a physical platform. Scalable
partitions are associated with scalable
systems and comprise only the scalable
nodes from their associated scalable
systems.

scalable system

An IBM Director managed object that
consists of scalable nodes and the scalable
partitions that are composed of the
scalable nodes in the scalable system.
When a scalable system contains two or
more scalable nodes, the servers that they
represent must be interconnected through
their SMP Expansion Modules to make a
multinode configuration, for example, a
16-way xSeries 455 server made from four
scalable nodes.

Secure Sockets Layer (SSL)

A security protocol that provides
communication privacy. SSL enables
client/server applications to communicate
in a way that is designed to prevent
eavesdropping, tampering, and message
forgery.

Service Location Protocol (SLP)

In the Internet suite of protocols, a
protocol that identifies and uses network
hosts without having to designate a
specific network host name.

service processor

SLP

A generic term for Remote Supervisor
Adapters, Advanced System Management
processors, Advanced System
Management PCI adapters, and integrated
system management processors (ISMPs).
These hardware-based management
processors used in IBM Netfinity and
xSeries servers work with IBM Director to
provide hardware status and alert
notification.

See Service Location Protocol.

SMBIOS

See systems management BIOS.

SMP Expansion Module

An IBM xSeries hardware option. It is a
single module that contains
microprocessors, disk cache, random
access memory, and three SMP Expansion
Port connections. Two SMP Expansion
Modules can fit in a chassis.

SNMP Access and Trap Forwarding

An IBM Director Agent feature that
enables SNMP to access managed-system
data. When installed on a managed
system, this feature enables SNMP-based
managers to poll the managed system and
receive its alerts. If System Health
Monitoring is installed on the managed
system also, hardware alerts can be
forwarded as SNMP traps.

SNMP device

SQL
SSL

A network device, printer, or computer
that has an SNMP device installed or
embedded.

See Structured Query Language

See Secure Sockets Layer.

static partition

A view-only scalable partition.

sticky key

An input method that enables the user to
press and release a series of keys
sequentially (for example, Ctrl+Alt+Del),
yet have the keys behave as if they were
pressed and released at the same time.
This method can be used for those who
require special-needs settings to make the
keyboard easier to use.
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Structured Query Language (SQL)
A standardized language for defining and
manipulating data in a relational
database.

switch module
The BladeCenter component that provides
network connectivity for the BladeCenter
chassis and blade servers. It also provides
interconnectivity between the
management module and blade servers.

system
The computer and its associated devices
and programs.

System Health Monitoring
An IBM Director Agent feature that
provides active monitoring of critical
system functions, including system
temperatures, voltages, and fan speeds. It
also handles in-band alert notification for
managed systems running Windows and
some managed systems running Linux.

system variable
A user-defined keyword and value pair
that can be used to test and track the
status of network resources. System
variables can be referred to wherever
event-data substitution is allowed.

systems management BIOS (SMBIOS)

A key requirement of the Wired for
Management (WfM) 2.0 specification.
SMBIOS extends the system BIOS to
support the retrieval of management data
required by the WfM specification. To run
IBM Director Agent, a system must
support SMBIOS, version 2.2 or later.

T

target system
A managed system on which an IBM
Director task is performed.

time to live (TTL)
A technique used by best-effort delivery
protocols to inhibit endlessly looping
packets. The packet is discarded if the
TTL counter reaches 0.

triple data encryption standard (DES)
A block cipher algorithm that can be used
to encrypt data transmitted between
managed systems and the management
server. Triple DES is a security
enhancement of DES that employs three
successive DES block operations.
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TTL  See time to live.

U

universal unique identifier (UUID)
A 128-bit character string guaranteed to
be globally unique and used to identify
components under management.

uptime
The time during which a system is
working without failure.

upward integration
The methods, processes and procedures
that enable lower-level
systems-management software, such as
IBM Director Agent, to work with
higher-level systems-management
software, such as Tivoli Enterprise’ " or
Microsoft SMS.

upward integration module
Software that enables higher-level
systems-management software, such as
Tivoli Enterprise or Microsoft Systems
Manager Server (SMS), to interpret and
display data provided by IBM Director
Agent. This module also can provide
enhancements that start IBM Director
Agent from within the higher-level
systems-management console, as well as
collect IBM Director inventory data and
view IBM Director alerts.

UUID See universal unique identifier.

\'}

vital product data (VPD)
Information that uniquely defines the
system, hardware, software, and
microcode elements of a processing
system.

VPD  See vital product data.

w

Wake on LAN®

A technology that enables a user to
remotely turn on systems for off-hours
maintenance. A result of the Intel-IBM
Advanced Manageability Alliance and
part of the Wired for Management
Baseline Specification, users of this
technology can remotely turn on a server
and control it across the network, thus



walk

saving time on automated software
installations, upgrades, disk backups, and
virus scans.

An SNMP operation that is used to
discover all object instances of
management information implemented in
the SNMP agent that can be accessed by
the SNMP manager.

Windows Management Instrumentation (WMI)

WMI

An application programming interface
(API) in the Windows operating system
that enables devices and systems in a
network to be configured and managed.
WMI uses the Common Information
Model (CIM) to enable network
administrators to access and share
management information.

See Windows Management Instrumentation.

WMI Query Language (WQL)

A subset of the Structured Query
Language with minor semantic changes to
support Windows Management
Instrumentation.

WQL See WMI Query Language.
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